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Basic operating instructions
PLUS-Solutions

This manual describes the general basic operation of the new "PLUS" programs of FRILO.

The PLUS programs are characterized by a "+" - in character after the program code (eg S9+).

User interface

Menu bar: Selection area and Input area
Hide / Show the left menu bar
Properties menu and input fields
Information area
Tip for beginners: Use the ENTER key!
Interactive graphic area
Ribbon bar

Input
Wizard
Interactive-Graphic — Input options
Direct links / Text links
Context menu (general)
Context menu of single elements
Tooltips
Direct entry of values
Zoom, move, 3D-rotation

Graphics / Document — the view selection

© 00 N O oo oo oo DOWOWWWWWDNDN

Ribbon bar

File tab

Start tab

Results tab 10
Data entry via tables - alternatives 11
Remarks Editor 12
Help - Hotline Service — Tips 13

In addition to the individual program manuals, you will find basic explanations on the operation of the
programs on our homepage www.frilo.com in the Campus-download-section.

Tip1: Back in the PDF - e.g. after a link to another chapter/document - use the key combination <ALT> + "Left
direction key".

Tip2: You can find answers to frequently asked questions at www.frilo.eu under » Service » Support » FAQ.
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User interface

The central elements of the new PLUS programs are:

= Menu bar and input area

Interactive graphic area

Wizard

Ribbon (multi-function to

Quick Access Toolba

(left side beneath Properties): can be faded_in and out using the pin-needle symbol.

olbar)

Output document (View selection)

r Tabs Ribbon

New item (Project” 4B) - 57+ Portal Frame 01/21A (R-2021-1/P0°

@ DHelp~

File Start
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=
System Loading Design Search | C:
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Input

Properties i

= [RE1S
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alculate Design Results s @ Code
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5| system | Load 02952

Document
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Save Connected Old
and back programs ~ codes

FRILO Software

(:! 8+ Save
: Permanent 1 e [
b Cases 7 s

Calculation Graphics Visibilities Fresentation Output and layouts

Graphics Document

. Basic Parameters

Y

- Cross-Sections

= - Boundary Conditions
[l Loads
(3 Design

Load Case - Permanent
DIN EN

Structural s

—7 v

View selection
Input-graphic/Output document

Graphic views

[ Output

Steel
Type
Grade

~

Structural steel
5235

2]

14

Characteristic values
System dimensions
Roof shape

Input dimensions
Outer width

Ridge distance left
Eaves height at left
Height of ridge

Eaves height at ight
Cantilever at left fm}
Cantilever at right

.a.hh

Ridged roof

Outer dimensions

Frame spacing
Posttion of frame Inner frame
Thickness wall-/ roof construction
Pitch

Roof side left

Roof side right

Remarks

.. about the system

The thickness of the wall structure can be entered
from outer edge column to outer edge of building
shell construction to improve the accuracy of the

model k

A J

1]

Change cross-section

Interactive graphic: Add support
directly editable

values

Add elastic foundation
Add load

Design using BTII+

Properti

Input area
- Input of data
- Selection options

Interactive graphic
context menu
(right mouse button)

SERV Absolute (Beam haunch)

7] Suppots | Standardloadcases | Additional Load Cases

| T abs for table display

help area / info

Menu bar: Selection area and Input area

If the menu bar is not displ

ayed on the left side, it can be displayed via the "Properties" tab — see the following

section “Hide / Show menu bar”.

All entries are divided into

useful areas in the menu, e.g. Basic Parameters, System, Loads, Design and Output.

By clicking on a menu item, the corresponding input areas or the individual input parameters are displayed.
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Hide / Show the left menu bar

If the menu on the Ieft.isn_otdisplayed an_d il S E Q0w s S E Q0w
you want it to show, click on the "Properties"”

tab on the left side. If you want to hide the File Start  Results File Start  Results
fixed menu bar again, click on the pin symbol.

41

== 2 | B Ul =2 = @
. . . . — lex : — Er
FRILO recommends interactive input in the i 1 Q EEC] - = : [ .
. . . Basic Calculate Design Resultg Basic Calculate Design
graphics window as the usual input type. N Demnmede

Input Ca Calculatio|
Properties n ? i Document
é:'EaSi.C parameter ao g H S EE a SHIC )
o B Pages Bookmats
=_1 A ‘ -
==
Properties menu and input fields
Use the items or sub-items of the menu to select the entries to be edited Properties i
in the input area. ¢ ' Q¢
P [ System @
Sub-items (recognizable by the preceding “+” sign) open when you click - Loads
on the “+” sign. - Design
) ) ) ) ) [ Output
The input area contains the input fields for data as well as options and
selection lists. Design Standards and Safety Concept o
Individual input sections that are rarely needed are often "collapsed" for Design Standard M DIN EN 1993 -
reasons of clarity and the space available. These can be accessed by wZfor crane loads 0.50
Lo ’ . Snow as accidertal loads
clicking onthe ™ —Unfold icon. :
Load factor for accidental snow 230
w2 = 0.5 for snow (AE) ]
Information area Location in windzone 3 or 4 |
o . . L . Equal vG for all permanent loads
As soon as you click in an input field, a description of the input value
. . . . Ulimate Limit State (37 ]
appears in the help and information area (below). The same explanation
also appears as a tool tip when the mouse pointer pauses over an input Serviceability ]
field.

Defines that - in addition to all ordinary design situations
- snow loads shall be also considered as accidental
loads.

Tip for beginners: Use the ENTER key!

Each ENTER takes you to the next input field. In this way you can go through the item input with the sequence
"Input - ENTER - input - ENTER etc. - without having to use the mouse. You can activate/deactivate options
with the space bar, you can also open selection lists and navigate in them with the direction keys.

Interactive graphic area

In addition to the customary definition options in the menu/input area, you can also enter particular values in
the graphical user interface and edit them there. The GUI allows you to edit data on the spot by simply clicking
onto the corresponding value or by use of the contextmenu (right mousebutton).

See also Interactive-Grafic — Input options.

Ribbon bar

The so-called Ribbon bar is a graphic operating concept known from modern applications (Microsoft Office /
Autocad ...) that connects menu control, toolbars and dialogs with one another.
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Input

By default, the input begins with the wizard.

The further entries are then mainly made in the interactive graphic — but you can use the the left menu bar
alternatively/simultaneously — see "Showing and hiding the menu bar".

Wizard

The use of the wizard is the fastest way for the initial input of an item.
If the default settings are unchanged, the wizard dialog appears automatically when the program starts.

Only the most important, basic system data is queried in a compact form. Then you can compute this basic
system and afterwards you can set up the details.

How to disable the wizard: option in the wizard window or » File » Program options.

Wizard
»
Create new structural item
L N
Wizard Templates Open
System
Truss system Double
Length m] 10.00
Left height m] 2.00
Height m] 3.00
Right height m] 2.00
Span 4
ivision of the spans constant span length ot
Girder spacing m] 2.00
Top chord ( default CS) b/h 8.0/16.0 cm =
Bottom chord (Standard €5)  b/h 8.0/16.0 cm = = 2
Past (default C5) b/h B.0/16.0 cm = ‘ 1
Diagonal struts ( default C5) byh 8.0/16.0 cm = :
Location | 230 230 230 230
Town = | 0.00
Activate/deactivate the wizard
Aways use the wizard to create a new item 0K Abort

Templates: an item template can be chosen as the starting point for a new item. A template can be created
via » File » Save as" » Option "Use as template" or via the item context menu in the FRILO
Control Center.

Open selection list with the items last used.
"Others..." button: Display of a window with the last used project.
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Interactive-Graphic — Input options

The interactive graphic is the usual type of input with newer program versions.

Direct links / Text links

For the most important general information, click on the text
links. The corresponding dialog is then displayed. These links
also provide information about the essential defined
parameters - e.g. the selected standard is displayed - the
dialog behind it usually has additional parameters.

This gives you an overview of the selected values at a glance.

Context menu (general)

Right-click in an empty area in the graphics window.
The general context-menu (see right) offers a number of
standard functions.

Context menu of single elements

When moving the mouse over the different elements in the
drawing the mouse pointer changes his style and the element
will be marked in a different color.

When right-clicking the appropriate context menu appears.

Double click on an element: opens the properties dialog of the
element directly.

Tooltips

When holding the mouse cursor over individual
graphical elements tooltips will show up.

Direct entry of values

Input fields are activated by clicking on the
respective value.

Example: The dimension is interactive, that is
you can click on a measure and then change
the value. The change is also visible in the
leftsided input area.

Zoom, move, 3D-rotation

Use the mouse wheel for zooming in and out.

Graphics Document

Roof load

5 Girder, Girder spacing: 2.00 m Text links
with Snow / with Wind

DIMN EN 1995:2013

Softwood 24

Material - Click to start Properties-Dialog i

View » Zoom
Basic Parameters gl
Systemn ¥ Love
Zoom in
lez=s Zoom out
>
Select load case T
Standard load cases ¥
Additional load cases ¥ HEtaufisn
Views |} > Isometry
Design " Front view
SRR > | View from behind
Output
) Top view
Print .
Bottorm view
View from right
View from left
>
»
Basic Parameters
Qutput >
Soil properties
Ground water
Surface
Checks soil engineering
Design h > Settings
Punching

Reinforcement

~3.00

Move the picture by pressing the right and left mouse button and moving the mouse. T~

For 3D-rotation hold down the right mouse button and move the mouse.
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Graphics / Document — the view selection

Graphics /Document tab: switch between input mode (graphic window) and the output preview (PDF).

The interactive input graphic is automatically displayed after the program starts.

The scope of the output can be defined via the Output menu item - this output profile can be saved in the
toolbar » Output and layouts section and reloaded if required.

If you click on this tab, the output document is displayed in PDF format.
If the position has not yet been calculated, you will receive a corresponding message.

The functions of the symbols for saving, printing, navigating in the document, searching PDF etc. can be
shown using tooltips. According to the usual functions of PDF display programs such as Acrobat Reader etc.

See FRILO Control Center » Page layout

M EES0w

Fle  Start  Results 2 DHelp~
f— el T | A o = T Y
= OO F L E @ X|can 5 == s Rl I
] . afi gt Roof load - 4 om F3) B
Basic  System Loading Design Search | Calculate Design Results A KK S ¥ Document - Save  Connected
parameter aF LY and back programs
Input Calculation = Load Cases Output and layouts FRILO Software ~
Propetties 2| Graphics | Document Saves the currertly selected output layoLt
I ao BAAn @-cux -0 AE@ OO0 et @0 @ -0- DEIDH [O]AM sopme
Kbl Pages  Bookmarks R N R R R R R R N R R e e s
- Design —
— ?
= :
= FRILO Software GmbH L
[ - Projekt ~.‘./“///
=== g Stuttgarter Str. 40 Tel.: +43 711 810020 Fosition: [ New item) -
General ] i 7469 Stumgart Fax: +49711 8100230 12/10/2020 Saite: 1 §
Brief output Page 1 G
Notes O Position: (New item)
System G 7
L @ 5 Trusses Timber PWH+ (1/2021 (FRILO R-2021-1/P02)
System graphics 20 il
System graphics 30 O 5 Basic Parameters
Force the scale O : Design code DIN EN 1895-1-1/NA:2013-08
Basis EN1995-1-1/42:3014
Loads (4] Safety concept / load combinatarics - DIN EN 1950/NA: 2010-12
¢ W, = 05 for snow (AE) : notconsiderad
Adtions - Permanent loads all equal Y (Ve OF Vi)
- CLED ati wind - Average of shortand very short
Load Case Graphics | Deta -
Results (2] z Material code N 338:2016
Suppart reaction- characteristic per load case 5 e h S B e
- Inftial deflection Wine = /300
Resit Graphics |LBete B Final deflection o = 17200
Resiting intem forces in table | Deta | Weetdn = /300

; System Double hip truss

= 2 = - *
JS
e '\
+ . \ = .
S 2] e\ g
2 -
e AN 3
- N N
| ‘ N
, ) - - s
< >
] Listofbars Topchord ] Listofbars Bottomehord ] Listofbars Post ] Listofbars Diagonalstrts ] Standard Load Cases | Additional LC x
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Ribbon bar

New item (Project: Stahl) - 57+ Portal Frame (x64) 01/23 (R-2023-1/P02)

File Start Results Help 2
N = 1 Ll L D Bss =
= oo F O RN B i W om
—_— = B O R [Ran m+n= RS —— i 3 ¥ e =
Basic  System Loading Design Search | Calculate Design Results A KR Code ‘-H System Load DICLAIE - SRR Document 3 Save Connected Old
parameter il - Cases ﬁ 84 Manage | and back programs = codes
Input Calculation Graphics Visibilities Presentation Output and layouts FRILO ~

The multi-function toolbar referred to as ribbon was introduced by Microsoft in the Microsoft Office 2007
version.

It is characterised by an operating concept that combines the control via menu items with buttons of a
toolbar.

Instead of menu items or menu bars, tabs such as
- File,

- Start or

- Results

are available.

A click on one of these tab options displays the associated function buttons (below), which are arranged in
command groups in view of the task to be accomplished.

By clicking on the small buttons with the v symbol, you can display Lill
additional functions. el &+ LoadCase :Permanent
This is a typical control of new Microsoft interfaces, but in FRILOPrograms it i >

is only used in a few cases. o )
System in wireframe graphics

If you click on the upper half of the symbol, the standard function is called
up. The lower half of the icon will become a selection list with more
functions displayed.

Systemn in 30 rendering b
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File tab

Usual standard functions.

II. right: File tabs in newer / former presentation

New

Open

Save

Save as

o
=.
>

=

Windows Layout

Create a new item. You usually use this
function. already in the
FRILO Control Center.

New
Open an existing item.

Projects and items of the project folder
last used in the FRILO Control Center
are displayed.

;7 Open

Save
Save the opened item under the existing

item name. If the item has not yet been =+ Saweas
named, "Save as" is carried out. )

Like "Save", but with explicit Print
specification of an item name and - if

necessary - selection of a project. Import

Printout of the output document on the
set printer. If the calculation has not yet
taken place, you will receive a
corresponding message from the
program.

EEREEALRQ DT

Export

Close

Settings

B &€

Import of e.g. ASCII data sets or Frilo
XML.

New

en

&

Save

Save As

Print

Import

BExport

Close

Program Options

Exit

Export of items as e.g. ASCII data sets, Frilo XML

The item is closed.

resets the window settings and restores the default state.

New Item when setting up a new item, a wizard supporting the user in the basic definition is
launched by default. You can optionally disable the wizard.
You can also disable the automatic computation which is launched each time you enter
or edit a value. Disabling is recommended when you are using a slow computer.

Graphics allows you select a colour setting (light / dark).

Units allows you to configure/edit the units/measures (mm, cm, m, kg, kN ...) used in the
software.
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Start tab

T DEEEW -
File Start Results Help

[ | ) 12

. . . . (] ama2c }

The available functions correspond to the menu items in the left = B = - g Mg (@D & 7
Basic  System Loading Design Search | Calculats Design Results | 5. o A Cods

sided menu bar. ;e

Input Calculation Graphics Visibilities

Froperties o
;- Basic Parameters [« ]
+- System )
- Loads

— Search

conneet]

Boundary Conditions / Column connection at left Copy
- Max / Min shear values

Input fields can be searched for using the magnifying glass
. .Connections Boundary Conditions / Column connection at right Cepy
symbol or the F3 key. | Advanced Stabity Anaysis O e

Example: Where is the input field for the roof load? e e e Ot o e

. ap - " " . . Design of Ultimate Limit State (]
Click on the magnifying glass, enter "roof" and all input fields that | me  pesgumegewnssry ~
contain the word "roof" in their designation are listed. A click on Remarks

one of the listed entries and the corresponding entry is displayed. ~'~**" = 4

Frame Comer / Connection beam screwed on support
Frame Comer / Connection - beam to column - welded

Frame Comer / Connection beam welded over support

You can start the calculation explicitly with "Calculate".

Auto on/off is a switch that enables automatic calculation after every modification (not recommended for
processor-intensive systems).

The status of the verification is displayed via a sort of traffic light.

Under "Results" you will find program-dependent functions for the graphic display of the results.

The button in the ribbon bar (calculation group) indicates with different traffic light colours iy
esign

whether the verifications have been successful.

- Gray indicates that the system is "not yet calculated".

- Green indicates that all verifications have been successful.

- Yellow indicates that permissible values have been exceeded or constructive problems have occurred.
- Red indicates that the verifications of the bearing capacity are not met.

By moving the mouse cursor over the traffic light button, a tool tip with the most important utilizations is
displayed. Clicking on the button displays a window that shows tips concerning exceeded limits and warning
notes in the corresponding situations.

The options for the graphical representations are explained by the tool tips (move the mouse cursor over a
button and wait a short time until the tip is displayed).

Various program-dependent options for displaying the system, dimensional chains, loads, etc. If these are not
self-explanatory, they are explained in more detail in the relevant manual.

The interfaces to other FRILO programs are listed and can be called up via the "Connected programs" icon.
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Results tab

The Results tab displays the functions for displaying the result graphics. You can display the explanation of
the individual functions as a tooltip (briefly persisting with the mouse). If separate explanations are necessary,
they are described in the manual for the respective program.

Fuil = E r%] 0w = MNew item (Project: 5B) - FWH+ Trusses Timber 01/2021 (R-2021-1/P02)
File Start Results D @Help~
1181 L | By n /n T{] 3
Gt e o I i |
Decisive Load LUSERGED {persisisntiransient) He Load N My Qz spatial n.lengitudinal n.shear n.stability
Combination ~ force
View Loads Inner forces Deformation Dimensicning ~
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Data entry via tables - alternatives

For the entry of data represented in tables, the following options are available. The load case table is taken as
an example to demonstrate the options.

1. Accessing tables via the table button (or the corresponding tab in the graphic window) and entering data
directly in the table cells.

2. Entering data in input fields in the FDC area by accessing the individual rows of a table via the table
toolbar.

Note: You can also alternate between the two methods of entering your data.

The functions of the table toolbar demonstrated by the example of the load case table:

Additional load case 0 22 OlaxBEBEBEEH
Table name Row navigation Insert Delete Delete tabledata Access table  Confirm
213

indicates the row number: The first number indicates the currently active row, the second one the
total number of rows.

o jumps to the next row upwards: the previous row is enabled and the values are displayed in the
corresponding cells.
uf jumps to the next row downwards: the following row is enabled and the values are displayed in the
corresponding cells.
Leb

inserts a new (empty) row below the currently active one.
deletes the currently active row.

delete the entire table contents.

FEIR

accesses the table, which is displayed in a traditional way and you can enter values directly in the

cells.
i

confirms the entered values.
Loads @ * Load Cases x
Load Cases 0 23 © X B 3 e -

i LA 4 Nz | Ml | el | gt [mayt | ot [ v | ot [t | i [ RS9 Hed T T T
Column loads L] [kN] Ur::‘ lrl:\l]‘l lrl“;‘lflvl lrl‘c_’l]‘l ich | it | iy | Tt [ml l:g{ lrl‘i‘I;J]a .
Description 1000 | 0.00| 0.00{0.00( 0.00| 00| 00| 00| 00| o©f 140 140|000/ 0.00| 0.00 -‘-*"
Vertical Force in Z LUl 0o - =% | 0.0|0.00|000| 000|000 00| 00| 00| 00| o©f 140 1.40|0.00( 000 0.00

1000 | 0.00| 0.00| 0.00| 0.00 00| 00| 00| 0| 140 140(0.00|000| 0.00
| Groundlayer | 7] LoadCases = | Single

Input section showing the values of the currently active table row.

Representation in form of a table (accessible via
the table button or the corresponding tab).
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Remarks Editor

Up to the 2020-1 release, remarks on positions, loads, etc. could only be saved as text.

Starting with Release 2020-2, the Remarks Editor can now also be used to carry out various formatting or
insert graphics and tables or special characters.

The remarks are inserted in the output document.

The operation is intuitive and takes place as it is usual in word processing programs.

FRILO Remarks Editor

Edit
I,
WG (A L. O BB
Save Faste [@ Caption it == Extra  Table Image Saved
and exit Characters Snippet
Save Clipboard Format Font Paraaraph Paste o~

With the Remarks Editor you can format your comments which are included in your output document
You can enter special characters likea, B, 5 ...

Superscript text: x2, %z

Include tables:

Headrow
Rows and columns

Include Graphics

FRILOS

ANEMETSCHEK COMPANY
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Help - Hotline Service — Tips

Under the menu item "Help" you will find the “Manual’-link and depending on the programme, further
supporting functions such as links to suitable video tutorials or a link to our section Frequently Asked
Questions (FAQ) on our homepage. You are also welcome to send us ideas, wishes and your personal opinion
about our programmes via the “Give feedback” function. In the "Information" section you will find the
programme version as well as update, patch and release information on the programme status.

FRILO Control Center (x64) - 02/ lelease <R-2023-2/P02>

ltems

Folder Projects

Programs

Customer number: <8823> Server: <SQLCE 4.0> £A Styles ~

Extras Help

B BBeoewmEH O ORBEBE

Manual Manual FAQ
FCC page layout

Group Help Contact

Here you can send a support request
directly by e-mail. This will save you
waiting time on the phone. Please enter
the subject of your enquiry (e.g.
installation, question about dimensioning
in the PLT programme, etc.) and a short,
clear description of the problem under
“Remarks:”.

You can attach a file via the "+" symbol (a
corresponding dialogue for selecting the
file is displayed) or a screenshot (a short
instruction text is displayed when you
click on the camera symbol).

Attach an item

In many cases, it is useful to attach the
item to the mail so that our support can
understand the problem. To do this, right-
click on the item in the FRILO Control
Center and select "Contact Support". You
will receive the same support request
window as described above, but the item

file will automatically be added to the mail.

Our hotline can also help you directly on your PC via remote maintenance using the popular TeamViewer
software. Of course, this must first be arranged with our hotline on the phone.

Contact Start Give
support TeamViewer feedback

Above Update Patch Releasze
FCC Info FCC  info info

Information ~

g} Send a web support request to FRILO Software GmbH - x

Customer contact: | Please select 2 customer cantact “|
Topic: PLT - printing the title block
Remarks: | have defined my own title block template and am having problems
printing it out.
Attachments: X Frilo.Screencapture_17_05_2023-025033,jpg 1291KB | Ldp
U

Add item file

() Additional Infos

0 I'm accepting the transmission of the shown data
” here.

‘ Send ‘ ‘ Cancel ‘

=

Start
TeamViewer

FRILO Software GmbH
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